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Chapter 302

Non-Inferiority Tests
for Two BetweenSubject Variances in
a 2×2M Replicated
Cross-Over Design
Introduction
This procedure calculates power and sample size of non-inferiority tests of between-subject variabilities from a
2×2M replicated cross-over design. This routine deals with the case in which the statistical hypotheses are expressed
in terms of the ratio of the between-subject variances.
This design is used to compare two treatments which are administered to subjects in different orders. The design has
two treatment sequences. Here, M is the number of times a particular treatment is received by a subject.
For example, if M = 2, the design is a 2×4 replicated cross-over. The two sequences might be
sequence 1: C T C T
sequence 2: T C T C
It is assumed that either there is no carry-over from one measurement to the next, or there is an ample washout
period between measurements.
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Technical Details
This procedure uses the formulation given in Chow, Shao, Wang, and Lokhnygina (2018), pages 213 - 216.
Suppose 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 is the response in the ith sequence (i = 1, 2), jth subject (j = 1, …, Ni), kth treatment (k = T, C), and lth
replicate (l = 1, ..., M). The mixed effect model analyzed in this procedure is
𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 = 𝜇𝜇𝑘𝑘 + 𝛾𝛾𝑖𝑖𝑖𝑖𝑖𝑖 + 𝑆𝑆𝑖𝑖𝑖𝑖𝑖𝑖 + 𝑒𝑒𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖

where 𝜇𝜇𝑘𝑘 is the kth treatment effect, 𝛾𝛾𝑖𝑖𝑖𝑖𝑖𝑖 is the fixed effect of the lth replicate on treatment k in the ith sequence, 𝑆𝑆𝑖𝑖𝑖𝑖1
and 𝑆𝑆𝑖𝑖𝑖𝑖2 are random effects of the ijth subject, and 𝑒𝑒𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 is the within-subject error term which is normally distributed
2
.
with mean 0 and variance 𝑉𝑉𝑘𝑘 = 𝜎𝜎𝑊𝑊𝑊𝑊
Unbiased estimators of these variances are found after applying an orthogonal transformation matrix P to the x’s as
follows
𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖 = 𝑃𝑃′𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖

2
.
where P is an m × m matrix such that 𝑃𝑃′𝑃𝑃 is diagonal and var�𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 � = 𝜎𝜎𝑊𝑊𝑊𝑊

Let 𝑁𝑁𝑠𝑠 = 𝑁𝑁1 + 𝑁𝑁2 − 2. In a 2×4 cross-over design the z’s become
𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖1 + 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖2
𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖1 =
= 𝑥𝑥̅𝑖𝑖𝑖𝑖𝑖𝑖 .
2
and
𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖2 =

𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖1 + 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖2

In this case, the within-subject variances are estimated as

and

2

√2

𝑁𝑁𝑖𝑖

= 𝑥𝑥̅𝑖𝑖𝑖𝑖𝑖𝑖 .

𝑀𝑀

2
𝑠𝑠𝑊𝑊𝑊𝑊

1
2
=
� � ��𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 − 𝑧𝑧̅𝑖𝑖.𝑇𝑇𝑇𝑇 �
𝑁𝑁𝑆𝑆 (𝑀𝑀 − 1)

2
𝑠𝑠𝑊𝑊𝑊𝑊

1
2
=
� � ��𝑧𝑧𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 − 𝑧𝑧̅𝑖𝑖.𝐶𝐶𝐶𝐶 �
𝑁𝑁𝑆𝑆 (𝑀𝑀 − 1)

𝑖𝑖=1 𝑗𝑗=1 𝑙𝑙=1
2

𝑁𝑁𝑖𝑖

𝑀𝑀

𝑖𝑖=1 𝑗𝑗=1 𝑙𝑙=1

Similarly, the between-subject variances are estimated as

and

where
𝑥𝑥̅𝑖𝑖.𝑘𝑘.

2

𝑁𝑁𝑖𝑖

2
𝑠𝑠𝐵𝐵𝐵𝐵

1
2
=
� ��𝑥𝑥̅𝑖𝑖𝑗𝑗𝑗𝑗. − 𝑥𝑥̅𝑖𝑖.𝑇𝑇. �
𝑁𝑁𝑆𝑆

2
𝑠𝑠𝐵𝐵𝐵𝐵

1
2
=
� ��𝑥𝑥̅𝑖𝑖𝑖𝑖𝑖𝑖. − 𝑥𝑥̅𝑖𝑖.𝐶𝐶. �
𝑁𝑁𝑆𝑆

𝑖𝑖=1 𝑗𝑗=1
2

𝑁𝑁𝑖𝑖

𝑖𝑖=1 𝑗𝑗=1

𝑁𝑁𝑖𝑖

1
= � 𝑥𝑥̅𝑖𝑖𝑖𝑖𝑖𝑖.
𝑁𝑁𝑖𝑖
𝑗𝑗=1
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2 )
2
2
Now, since 𝐸𝐸(𝑠𝑠𝐵𝐵𝐵𝐵
+ 𝜎𝜎𝑊𝑊𝑊𝑊
/𝑀𝑀, estimators for the between-subject variance are given by
= 𝜎𝜎𝐵𝐵𝐵𝐵
2
2
2
= 𝑠𝑠𝐵𝐵𝐵𝐵
− 𝜎𝜎�𝑊𝑊𝑊𝑊
/𝑀𝑀
𝜎𝜎�𝐵𝐵𝐵𝐵

The sample between-subject covariance is calculated using
2
𝑠𝑠𝐵𝐵𝐵𝐵𝐵𝐵

2

𝑁𝑁𝑖𝑖

1
=
� ��𝑥𝑥̅𝑖𝑖𝑖𝑖𝑖𝑖. − 𝑥𝑥̅𝑖𝑖.𝑇𝑇. ��𝑥𝑥̅𝑖𝑖𝑖𝑖𝑖𝑖. − 𝑥𝑥̅𝑖𝑖.𝐶𝐶. �
𝑁𝑁𝑆𝑆
𝑖𝑖=1 𝑗𝑗=1

Using this value, the sample between-subject correlation is easily calculated.

Testing Variance Non-Inferiority
The following statistical hypotheses are used to test for between-subject variance non-inferiority.

where R0 is the non-inferiority limit.

2
2
𝜎𝜎𝐵𝐵𝐵𝐵
𝜎𝜎𝐵𝐵𝐵𝐵
𝐻𝐻0 : 2 ≥ 𝑅𝑅0 versus 𝐻𝐻1 : 2 < 𝑅𝑅0,
𝜎𝜎𝐵𝐵𝐵𝐵
𝜎𝜎𝐵𝐵𝐵𝐵

2
2
2
2
− 𝑅𝑅0𝜎𝜎𝐵𝐵𝐵𝐵
be the parameter of interest. The test statistic is 𝜂𝜂̂ = 𝜎𝜎�𝐵𝐵𝐵𝐵
− 𝑅𝑅0𝜎𝜎�𝐵𝐵𝐵𝐵
.
Let 𝜂𝜂 = 𝜎𝜎𝐵𝐵𝐵𝐵

Non-Inferiority Test

For the non-inferiority test, compute the limit 𝜂𝜂̂ 𝑈𝑈 using
Reject the null hypothesis if 𝜂𝜂̂ 𝑈𝑈 < 0.

𝜂𝜂̂ 𝑈𝑈 = 𝜂𝜂̂ + �Δ𝑈𝑈

The Δ is given by

where

Δ𝑈𝑈 = ℎ(1 − 𝛼𝛼, 𝑁𝑁𝑠𝑠 − 1)𝜆𝜆12 + ℎ(𝛼𝛼, 𝑁𝑁𝑠𝑠 − 1)𝜆𝜆22 + ℎ�1 − 𝛼𝛼, 𝑁𝑁𝑠𝑠 (𝑀𝑀 − 1)�
ℎ(𝐴𝐴, 𝐵𝐵) = �1 −
𝜆𝜆2𝑖𝑖 = ⎛

and

2
𝜒𝜒𝐴𝐴,𝐵𝐵

⎝

𝐵𝐵
2 �
𝜒𝜒𝐴𝐴,𝐵𝐵

2

2
2
2 )2
4
2
𝑠𝑠𝐵𝐵𝐵𝐵
− 𝑠𝑠𝐵𝐵𝐵𝐵
± �(𝑠𝑠𝐵𝐵𝐵𝐵
+ 𝑠𝑠𝐵𝐵𝐵𝐵
− 4(𝑅𝑅0)𝑠𝑠𝐵𝐵𝐵𝐵𝐵𝐵

2

4
4
𝜎𝜎�𝑊𝑊𝑊𝑊
𝜎𝜎�𝑊𝑊𝑊𝑊
(𝑀𝑀
+
ℎ�𝛼𝛼,
𝑁𝑁
−
1)�
𝑠𝑠
𝑀𝑀2
𝑀𝑀2

⎞ for 𝑖𝑖 = 1,2
⎠

is the upper quantile of the chi-square distribution with B degrees of freedom.
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Power
Non-Inferiority Test
The power of the non-inferiority test is given by
Power = Φ �𝑧𝑧𝛼𝛼 −

where
𝑅𝑅1 =

2
(𝑅𝑅1 − 𝑅𝑅0 )𝜎𝜎𝐵𝐵𝐵𝐵

2
𝜎𝜎𝐵𝐵𝐵𝐵
2
𝜎𝜎𝐵𝐵𝐵𝐵

2
2
= 𝑅𝑅1 𝜎𝜎𝐵𝐵𝐵𝐵
𝜎𝜎𝐵𝐵𝐵𝐵

2
𝜎𝜎 ∗2 = 2 ��𝜎𝜎𝐵𝐵𝐵𝐵
+

2

�𝜎𝜎 ∗2 /𝑁𝑁𝑠𝑠

�

2

2
4
2
4
𝜎𝜎𝑊𝑊𝑊𝑊
𝜎𝜎𝑊𝑊𝑊𝑊
𝜎𝜎𝑊𝑊𝑊𝑊
𝑅𝑅02 𝜎𝜎𝑊𝑊𝑊𝑊
2
4 2
+
+ 2
− 2𝑅𝑅0 𝑅𝑅1 𝜎𝜎𝐵𝐵𝐵𝐵
𝜌𝜌 �
� + 𝑅𝑅02 �𝜎𝜎𝐵𝐵𝐵𝐵
� + 2
𝑀𝑀
𝑀𝑀
𝑀𝑀 (𝑀𝑀 − 1) 𝑀𝑀 (𝑀𝑀 − 1)

where R1 is the value of the variance ratio stated by the alternative hypothesis and Φ(𝑥𝑥) is the standard normal
CDF.
A simple binary search algorithm can be applied to the power function to obtain an estimate of the necessary
sample size.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and
power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power or Sample Size.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
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Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis when it is
true.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)
Sequence Allocation
Select the option that describes the constraints on N1 or N2 or both.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each sequence. Since you are solving for
both sample sizes at once, no additional sample size parameters need to be entered.

•

Enter N2, solve for N1
Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note
that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.

•

Enter R = N2/N1, solve for N1 and N2
For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2,
with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
N2 = R * N1.

•

Enter percentage in Sequence 1, solve for N1 and N2
For this choice, you set a value for the percentage of the total sample size that is in Sequence 1, and then
PASS determines the needed N1 and N2 with this percentage to obtain the desired power.

N2 (Sample Size, Sequence 2)
This option is displayed if Sequence Allocation = “Enter N2, solve for N1”
N2 is the number of items or individuals sampled from the Sequence 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
R (Sequence Sample Size Ratio)
This option is displayed only if Sequence Allocation = “Enter R = N2/N1, solve for N1 and N2.”
R is the ratio of N2 to N1. That is,
R = N2 / N1.
Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this
ratio are considered.
N2 is related to N1 by the formula:
N2 = [R × N1],
where the value [Y] is the next integer ≥ Y.
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For example, setting R = 2.0 results in a Sequence 2 sample size that is double the sample size in Sequence 1 (e.g.,
N1 = 10 and N2 = 20, or N1 = 50 and N2 = 100).
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single or a series of values.
Percent in Sequence 1
This option is displayed only if Sequence Allocation = “Enter percentage in Sequence 1, solve for N1 and N2.”
Use this value to fix the percentage of the total sample size allocated to Sequence 1 while solving for N1 and N2.
Only sample size combinations with this Sequence 1 percentage are considered. Small variations from the
specified percentage may occur due to the discrete nature of sample sizes.
The Percent in Sequence 1 must be greater than 0 and less than 100. You can enter a single or a series of values.

Sample Size (When Not Solving for Sample Size)
Sequence Allocation
Select the option that describes how individuals in the study will be allocated to Sequence 1 and to Sequence 2.
The options are
•

Equal (N1 = N2)
This selection is used when you wish to have equal sample sizes in each sequence. A single per sequence
sample size will be entered.

•

Enter N1 and N2 individually
This choice permits you to enter different values for N1 and N2.

•

Enter N1 and R, where N2 = R * N1
Choose this option to specify a value (or values) for N1, and obtain N2 as a ratio (multiple) of N1.

•

Enter total sample size and percentage in Sequence 1
Choose this option to specify a value (or values) for the total sample size (N), obtain N1 as a percentage of N,
and then N2 as N - N1.

Sample Size Per Sequence
This option is displayed only if Sequence Allocation = “Equal (N1 = N2).”
The Sample Size Per Sequence is the number of items or individuals sampled. Since the sample sizes are the same
in each sequence, this value is the value for N1, and also the value for N2.
The Sample Size Per Sequence must be ≥ 2. You can enter a single value or a series of values.
N1 (Sample Size, Sequence 1)
This option is displayed if Sequence Allocation = “Enter N1 and N2 individually” or “Enter N1 and R, where N2
= R * N1.”
N1 is the number of items or individuals sampled from the Sequence 1 population.
N1 must be ≥ 2. You can enter a single value or a series of values.
N2 (Sample Size, Sequence 2)
This option is displayed only if Sequence Allocation = “Enter N1 and N2 individually.”
N2 is the number of items or individuals sampled from the Sequence 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.
302-6
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Non-Inferiority Tests for Two Between-Subject Variances in a 2×2M Replicated Cross-Over Design

R (Sequence Sample Size Ratio)
This option is displayed only if Sequence Allocation = “Enter N1 and R, where N2 = R * N1.”
R is the ratio of N2 to N1. That is,
R = N2/N1
Use this value to obtain N2 as a multiple (or proportion) of N1.
N2 is calculated from N1 using the formula:
N2=[R x N1],
where the value [Y] is the next integer ≥ Y.
For example, setting R = 2.0 results in a Sequence 2 sample size that is double the sample size in Sequence 1.
R must be greater than 0. If R < 1, then N2 will be less than N1; if R > 1, then N2 will be greater than N1. You can
enter a single value or a series of values.
Total Sample Size (N)
This option is displayed only if Sequence Allocation = “Enter total sample size and percentage in Sequence 1.”
This is the total sample size, or the sum of the two sequence sample sizes. This value, along with the percentage
of the total sample size in Sequence 1, implicitly defines N1 and N2.
The total sample size must be greater than one, but practically, must be greater than 3, since each sequence sample
size needs to be at least 4.
You can enter a single value or a series of values.
Percent in Sequence 1
This option is displayed only if Sequence Allocation = “Enter total sample size and percentage in Sequence 1.”
This value fixes the percentage of the total sample size allocated to Sequence 1. Small variations from the
specified percentage may occur due to the discrete nature of sample sizes.
The Percent in Sequence 1 must be greater than 0 and less than 100. You can enter a single value or a series of
values.
M (Number of Replicates)
Enter one or more values for M: the number of replicates in a 2 × 2M replicated cross-over design. M is the
number of times each treatment is measured on each subject.
For example, M = 2 refers to a 2 × 4 replicated cross-over design. The two sequences used for this design are
often
Sequence 1: R T R T
Sequence 2: T R T R.
You can enter a single value such as 2, a series of values such as 2 3 4, or 2 to 8 by 1.
The range is M ≥ 2.
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Effect Size
R0 (Non-Inferiority Variance Ratio)
Enter one or more values for the non-inferiority limit for the ratio of the two between-subject variances. When the
ratio of the sample variances is less than this value, the treatment group is concluded to be “non-inferior” to the
control group.
This value must be greater than one. Popular choices are 1.5 and 2.
R1 (Actual Variance Ratio)
Enter one or more values for between-subject variance ratio assumed by the alternative hypothesis. This is the
value of σ²вᴛ/σ²вᴄ at which the power is calculated.
The range of possible values is 0 < R1 < R0.
σ²вᴄ (Control, Between-Subject Variance)
Enter one or more values for between-subject variance of the average subject control measurements. This value
will have to be determined from a previous study or a pilot study.
The range of possible values is σ²вᴄ > 0.
σ²ᴡᴛ (Treatment, Within-Subject Variance)
Enter one or more values for within-subject variance of the treatment measurements. This value will have to be
determined from a previous study or a pilot study.
The range of possible values is σ²ᴡᴛ > 0.
σ²ᴡᴄ (Control, Within-Subject Variance)
Enter one or more values for within-subject variance of the control measurements. This value will have to be
determined from a previous study or a pilot study.
The range of possible values is σ²ᴡᴄ > 0.
ρ (Treatment, Control Correlation)
Enter one or more values for the between-subject (intersubject) correlation. This is the correlation between the
two group means, treatment and control, calculated on each subject. That is, the means are averaged across
replicates within a subject.
This value will have to be determined from a previous study or a pilot study.
The range of possible values is -1 ≤ ρ ≤ 1.
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Example 1 – Finding Sample Size
A company has developed a generic drug for treating rheumatism and wants to show that it is non-inferior to the
standard drug in terms of the between-subject variability. A 2 x 4 cross-over design will be used to test the noninferiority.
Company researchers set the non-inferiority limit to 1.5, the significance level to 0.05, the power to 0.90, M to 2,
and the actual variance ratio values between 0.9 and 1.3. They also set σ²вᴄ = 0.4, σ²ᴡᴛ = 0.2, σ²ᴡᴄ = 0.3, and ρ =
0.75. They want to investigate the range of required sample size values assuming that the two sequence sample
sizes are equal.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Non-Inferiority Tests for Two Between-Subject Variances in a 2×2M Replicated CrossOver Design procedure window. You may then make the appropriate entries as listed below, or open Example 1
by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Sequence Allocation ............................... Equal (N1 = N2)
M (Number of Replicates) ....................... 2
R0 (Non-Inferiority Variance Ratio) ........ 1.5
R1 (Actual Variance Ratio) ..................... 0.9 1 1.1 1.2 1.3
σ²вᴄ (Control Variance) .......................... 0.4
σ²ᴡᴛ (Treatment Variance) ..................... 0.2
σ²ᴡᴄ (Control Variance) .......................... 0.3
ρ (Treatment, Control Correlation).......... 0.75

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
H0: σ²вᴛ/σ²вᴄ ≥ R0 vs. H1: σ²вᴛ/σ²вᴄ < R0

Actual
Power
0.9011
0.9010
0.9009
0.9005
0.9001

Seq 1
Seq 2
Sample Sample
Size
Size
N1
N2
107
107
156
156
248
248
450
450
1038
1038

N
214
312
496
900
2076

Num
Reps
M
2
2
2
2
2

NonInf
Var
Ratio
R0
1.500
1.500
1.500
1.500
1.500

Actual
Var
Ratio
R1
0.900
1.000
1.100
1.200
1.300

Betw
Subj
Var
Cntl
σ²вᴄ
0.400
0.400
0.400
0.400
0.400

Wthn
Subj
Var
Trt
σ²ᴡᴛ
0.200
0.200
0.200
0.200
0.200

Wthn
Subj
Var
Cntl
σ²ᴡᴄ
0.300
0.300
0.300
0.300
0.300

Corr
Trt
vs
Cntl
ρ
0.750
0.750
0.750
0.750
0.750

Alpha
0.050
0.050
0.050
0.050
0.050

References
Chow, S.C., Shao, J., Wang, H., and Lokhnygina, Y. 2018. Sample Size Calculations in Clinical Research, Third
Edition. Taylor & Francis/CRC. Boca Raton, Florida.
Chow, S.C. and Liu, J.P. 2014. Design and Analysis of Clinical Trials, Third Edition. John Wiley & Sons.
Hoboken, New Jersey.
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Report Definitions
Actual Power is the actual power achieved. Because N1 and N2 are discrete, this value is usually slightly
larger than the target power.
N1 is the number of subjects in sequence 1.
N2 is the number of subjects in sequence 2.
N is the total number of subjects. N = N1 + N2.
M is the number of replicates. That is, it is the number of times a treatment measurement is repeated on a
subject.
R0 is the non-inferiority limit for the between-subject variance ratio.
R1 is the value of the between-subject variance ratio at which the power is calculated.
σ²вᴄ is the between-subject variance of measurements in the control group.
σ²ᴡᴛ is the within-subject variance of measurements in the treatment group.
σ²ᴡᴄ is the within-subject variance of measurements in the control group.
ρ is the between-subject correlation of the average subject treatment-group measurements versus the average
subject control-group measurements.
Alpha is the probability of rejecting a true null hypothesis, H0.
Summary Statements ─────────────────────────────────────────────────────────
A study is being conducted to assess the non-inferiority of the within-subject variability of
two groups by looking at the ratio of their variances. If the sample variance ratio falls below
the non-inferiority limit, the treatment (group 1) is concluded to be 'non-inferior' to the
reference group. Otherwise, it is not. The design of the study is a 2×2M replicated cross-over
design. Sequence sample sizes of 107 and 107 achieve 90% power to reject the null hypothesis at
a significance level of 0.050. The non-inferiority limit is 1.500.The variance ratio at which
the power is calculated is 0.900. The number of times each treatment measurement is repeated on
a subject is 2. The actual between-subject variance of the control group is assumed to be
0.400. The actual within-subject variance of the treatment group is assumed to be 0.200. The
actual within-subject variance of the control group is assumed to be 0.300. The between-subject
correlation between the average treatment measurement per subject and the average control
measurement per subject is assumed to be 0.750.

This report gives the sample sizes for the indicated scenarios.

Plot Section

This plot shows the relationship between sample size and R1.
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Example 2 – Validation using Chow et al. (2018)
We will use an example from Chow et al. (2018) page 217 to validate this procedure.
In this example, R0 = 1.21, significance level = 0.05, power = 0.80, M = 2, σвᴛ = 0.3, σвᴄ = 0.4, σᴡᴛ = 0.2, σᴡᴄ
= 0.3, and ρ =0.75. From these values, we find that R1 = 0.5625. The resulting sample size, after some rounding,
is found to be 34 per sequence. (There is a typo in the book which puts the value at 29. This is an obvious error
since Ns – 2 is found to be 66.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Non-Inferiority Tests for Two Between-Subject Variances in a 2×2M Replicated CrossOver Design procedure window. You may then make the appropriate entries as listed below, or open Example 2
by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.80
Alpha ....................................................... 0.05
Sequence Allocation ............................... Equal (N1 = N2)
M (Number of Replicates) ....................... 2
R0 (Non-Inferiority Variance Ratio) ........ 1.21
R1 (Actual Variance Ratio) ..................... 0.5625
σ²вᴄ (Control Variance) .......................... 0.16
σ²ᴡᴛ (Treatment Variance) ..................... 0.04
σ²ᴡᴄ (Control Variance) .......................... 0.09
ρ (Treatment, Control Correlation).......... 0.75

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
H0: σ²вᴛ/σ²вᴄ ≥ R0 vs. H1: σ²вᴛ/σ²вᴄ < R0

Actual
Power
0.8097

Seq 1
Seq 2
Sample Sample
Size
Size
N1
N2
35
35

N
70

Num
Reps
M
2

NonInf
Var
Ratio
R0
1.210

Actual
Var
Ratio
R1
0.563

Betw
Subj
Var
Cntl
σ²вᴄ
0.160

Wthn
Subj
Var
Trt
σ²ᴡᴛ
0.040

Wthn
Subj
Var
Cntl
σ²ᴡᴄ
0.090

Corr
Trt
vs
Cntl
ρ
0.750

Alpha
0.050

The per-group sample size of 35 is one more than the value of 34 which is given in the reference. Their number
yields a power that is slightly less than the desired 0.8, so PASS has increased the sequence sizes by one to 35.
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